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Moxa Tech Note How to Configure KingSCADA with MGate 5105

1 Application Description

This application shows how to set up a KingSCADA system to control and monitor
Allen-Bradley PLC tags which are transmitted from MGate 5105.

For more information about Allen-Bradley PLC communication with MGate 5105, refer to the
documents Configuring Allen-Brandly ControlLogix PLC with Moxa MGate 5105-MB-EIP and How
to Configure Pro-face HMI with Allen-Bradley PLC.

2 System Topology

The following figure shows a system topology where the Modbus end devices, PowerFlex 4M
and IAQPoint2, are connected to the serial port on MGate 5105-MB-EIP through RS-485-2W
wiring. MGate 5105-MB-EIP and PC (with RSLogix 5000 and KingSCADA installed) are
connected to the Ethernet switch ports on Allen-Bradley ControlLogix PLC via Ethernet cables.
A fan is connected to PowerFlex 4M that outputs electric current to power the fan.

PC (RSLogix 5000, KingScada)

Information

Level Ethernet
Control Allen-Bradley Ethernet
Level ControlLogix PLC

(Ethernet/IP)

Device
Level

Power Flex 4M Fan IAQPoint2
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3 Hardware and Software Requirements

Allen-Bradley ControlLogix PLC:
- Processor: 1756 L71 ControlLogix5571
- Chassis: 1756-A7
— EIP Module: 1756-EN2TR
e PowerFlex 4M:
PowerFlex 4M is an adjustable frequency AC drive (converter).
e IAQPoint2:
IAQPoint2 is an indoor air quality monitor. It can detect CO2, temperature and humidity
levels.
¢ KingSCADA:
A SCADA system released by WellinTech.
Rev.: V3.1.
e RS Logix 5000:
Allen-Bradley ControlLogix PLC Edit Program from Rockwell Automation.
- Rev.: V20
— Operating System Support:
The RSLogix 5000 V20 software has been tested on the following operating systems:

a. Microsoft Windows 7 Professional (64-bit) with Service Pack 1

b. Microsoft Windows 7 Home Premium (64-bit) with Service Pack 1

c. Microsoft Windows 7 Home Premium (32-bit) with Service Pack 1

d. Microsoft Windows Vista Business (32-bit) with Service Pack 2

e. Microsoft Windows XP Professional with Service Pack 3

f.  Microsoft Windows Server 2008 R2 Standard Edition with Service Pack 1

g. Microsoft Windows Server 2008 Standard Edition with Service Pack 2

h. Microsoft Windows Server 2003 R2 Standard Edition with Service Pack 2
e RSLinx:

Communication Utility from Rockwell Automation.
Rev.: 2.59
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4 About KingSCADA 3.1

KingSCADA 3.1 consists of the following components: KingSCADA3.1
o KingIOServer: This component acquires data from I/0 &) Uninstall KingSCADA
: KinglOServer
devices.

4Ir 10 Driver Install
% I0Server Configure
i I0Server Driver
& I0Server Monitor
i I0Server User Manual
£ Uninstall KinglODriver
King5CADA
M Scadalake
 ScadaView

Scada Tool

User Manual

e KingScada:
— ScadaMake: This is the development environment.

— ScadaView: This is the runtime application.

The following sections describe these components.

4.1 About KingIO Server

A KingSCADA station communicates with I/O devices through KingIOServer. KingIOServer
is used to communicate with the on-site devices and acquire real-time data and control
on-site data of the modules.

KingIOServer supports popular PLC, intelligent module, intelligent instrument, transducer,
and data acquisition boards, etc.

In addition, KingIlOServer can communicate with devices through standard communicate
interface to transfer data.

With KingIOServer, site engineers are not required to be familiar with the codes and device
communication protocols. Instead, they only need to know how to connect with I/O
devices and create tags corresponding with the I/0O variables.
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4.2 About KingSCADA

You can use KingSCADA is to create a project with data and display.
The following lists the major steps to create a project:

Step1: Create a new project
Create a new directory to store the documents associated with the project.

Step2: Configure the hardware
Configure the hardware settings of the equipment used in the project.

Step3: Define variables (tags)
Define global variables including memory variables and I/O devices.

Step4: Create graphics:
Draw monitoring pictures according to the project requirements.

Step5: Define animation links
Based on the on-site monitoring requirements, define the animation effects for static
pictures to simulate process control objects.

Step6: Write an event script
Create scripts in order to complete the control process.

Step7: Configure of other necessary functions
Configure settings such as networks, recipes, SQL access, and web browsing.

Step8: Operate and debug the project.

After you complete the procedure as described, you can create a simple project.
Then, you can run ScadaView to start run-time operations.
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4.3 KingScada System Architecture

In a large system, the KingScada ystem may deploy some services on multiple servers for

load sharing or for security considerations. For example, a run-time project can be

executed on KingScada Station for monitoring, on HMI View for controlling, and on

another Database Server for data acquisition and storage. In addition, the web portal

can be hosted on another Web Server and data can be obtained though several I0

Servers.

In this document, we show hot to create an IO server and Run-Time View on the same PC.

Database Server

KingScada

Web Server

10 Server

10 Server

3540 o ,
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5 KingSCADA Configuration

5.1 Creating an IO Server Project

To start the IOServer Configure application, click |, KingSCADA3.1

Start - Program - KingSCADA3.1 - 5 Uninstall KingSCADA
KingIOServer > I0Server Configure to create an |, KinglOServer

45 10 Driver Install

% I0Server Configure
(¥ IOServer Driver

& [OServer Monitor
& I0Server User Manual
&5 Uninstall KingIODriver

IO Server project.

5.1.1 Creating an IO Server

1. In the IOServer screen, click File > New IOServer to create a new IO server.

l-¢l||

= I0%erver
Edit Wiew Acguisiion Tools Help

Recent Projects 3

Exit

2. In the New IOServer screen, configure the following fields and click OK:
¢ Project Name: Enter a descriptive name.
e Location: Click the ... button to choose a location to store the project.
e Type: Select I0Server From Driver from the drop-down list.

New IOServer |

Project Name: [ab ‘

Location: I C:\Program Files\KingSCADA\My Projects\MGate5105 I IE]
Type: I0Server From Driver l v ‘

Lok | [ concel |
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5.1.2 Creating an IO Channel

1. Right-click Device Tree 2> Project-‘ab’ and select New Channel. A New Channel

dialog box appears.

. 10Server-C:\Program Files\KingSCADA\My Projects\MGate5105ab\

. File Edit View Acquision Tools Help

: piiNew £3Open pf” Close | ) Start # Diagnosis == Deb
75

New Channel...

Paste

Edit

2. In the New Channel dialog box, configure the following fields and click NEXT.
¢ Channel Name: Enter a descriptive name.
e Device Driver: Select ControlLogix from the drop-down list.
e Channel Type: Use the default option.

'New Channel |

hannel name can not contamns following charecters,: +- ¥ %! ~P<>={}[]().>"'?, and the
irst character can not be numbers.
elect the device driver o assign to the channel,

drop-down list below contains all the drivers installed on your system.

Device Driver. ~
Channel Type:  [Serial Port v
<BACK | _NEXT»> | [ CANCEL |

3. Accept the default timeout setting (3000 ms) and click NEXT.
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Mew Channel @
met the channel connection fmeout here.
Timeont range: 0-05535 ms
Timeont; |m s
| <BACK || NEXT- | | CANCEL |

4. Since this channel is connected through Ethernet, use the default settings for the serial
port. Click NEXT to continue.

Mew Channel @
Thiz 1z the serial port sethng.
Flease make sure that it is the same with the setting of device.
Port ID: Bavd Rate: (9600 | =
SL A —
sy Fov.
<BACK | NEXT- | | CANCEL

5. Click Finish to complete the “Allen-Bradley ControlLogix PLC” channel setting.

Copyright © 2014 Moxa Inc.
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F—
Summary E

B Channel Basic Settings -

m

B Serial Port Settings

| <BACK || FINISH | | CANCEL |

5.1.3 Creating an I0 Device

1. Right-click the abc channel and select New Device.

Copy
Paste
Delete

Edit

Set Block Order...

2. Inthe New Device screen that appears, configure the following fields and click NEXT:
e Device Name: Enter a descriptive name.

Copyright © 2014 Moxa Inc. Page 10 of 30




Moxa Tech Note

How to Configure KingSCADA with MGate 5105

e Device Series: Select AB-ControlLogixTCP from the drop-down list.

evice name con not contains following characters , #-¥%l~P<>={}[10."\?, and the
irst character can not be numbers.
The device you are defining uses a device driver that supports more than one sexes.
The list below shows all supported series.

Device Name: | abl 756

Device Sexies: I AB-ControlLogixTCP | v I

"] Assign Redundant Secondaxry Device

New Device @

[ NEXT»> | [ CANCEL

)

In the Device Address field, enter the IP address and communication
Allen-Bradley ControlLogix PLC in the format [IP Backplane Slot]. T
NEXT.

parameter of
hen, click

Mew Device @

The device wou are defiming may be multidropped as part of & network of devices.

1 order to comumunicate with the dewvice, it must be azsigned a wnigue address.

Device Address: | 192.168.32231 1,0 | Help
<BACK || HNEXT» | | CANCEL

Accept the default settings and click NEXT to continue.

Copyright © 2014 Moxa Inc.
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Mew Device @

A frer device haz ermor, I0%erver will tror to recavery the commmndcation with it
Thiz iz the timing parameters that won can confizore.
Fecovery interval range: 5 2 - 1440 min
Fecovery Time range: 5 s- 30 days

Eecovery Intepeal: |E || Seconds | - |

Recovery Time: |24 || Hours | - |

Dvmamic Optimization
<BACK | NEXT- | | CANCEL

5. Click Finish to complete the device setting.

Summary

=)

)

| <BACK | FINISH | [ CANCEL

5.2 Creating a SCADA Project

Copyright © 2014 Moxa Inc.
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1. To start the ScadaMake application, click Start . KingSCADA31
> Program - KingSCADA3.1 > ScadaMake. £} Uninstall KingSCADA
, KinglOServer
. KingSCADA,

W Scadalake
M ScadaView
; Scada Tool

; User Manual

2. Click File > New Solution to create a new solution.

# Make __ T

|F||e_ Edit View Compile Tools Help

[E] riew solution @ Find | @] Large [

~ Kagt Open Project/Solution...

Solution Item
Add Mew Praject

* Add Exist Project ..

Remaove Project
Close Solution
Recent Solutions 3

Exit

3. Give a project name then click OK. System would create a new empty project.

New project e S
e v
Project Statement
Name: MGate5105 I
Location: C:\Program Files\KingSCADA My Projects E]
Project ISEl'VEf Project L
Solution: @ New solution ) Add to currrent solution

Solution name: MGate5105

Informations
Author: General_Chiang

Company:
Create time: 2014-10-07 10:55:29

Description:

<4 [

L J

5.3 Building Tags
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1. Under Build Tags, right-click IO SERVER and click New. The New IOServer screen

appears.

[ Solution 'MGate5105'
=29 MGate5105
54 HMI
=) ey View
i 1.[E4) Picture
i3 Graphics Model
..[#5] HMI View Setting

- (=] Build Tags

biNew X

Name

a
L] ||:Ei;s!iir

<2l Data ModelInstance
.[T] Struct Template
«| Data Model
/Z] Nonlinear Tables
| L @ Alarm Groups
-3 System Setup

2. In the New IOServer screen, enter a server name in the Name field and click OK.
Note: Since this IO Server is hosted on the same computer, the IP address is

unchanged at 127.0.0.1.

New [OServer &
Setting
Name: MGateIOServer ! oK
e
Cancel
IP Address: 127.0.0.1 Backup IP:
Port: 12330

HeartBeat Interval(ms): 1000

"] Auto Boot I0Server Server

I0Server Project Path:

| Timing I0Server Machine

Timing Interval(s): 600

["] use Double-10Server Hotstandby

TryConnectTimes: 2

3. Click Build Tags 2> Tag Dictionary and click New. The Tag Properties screen appears.

Copyright © 2014 Moxa Inc.
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[ Selution 'MGate5105' v New |Edit X Delaie Tag Properties - — (x
] MGate5105 < = — -
= MName Desg T
= HMI r Tag Name: | 01 a9 Type
5 a View ki, Svear peta Type: | @Basic  Struct () Peinter
3] Picture Ll SMonth Ype: |MamDiec -
& Graphics Modhl | ki) SDayofweek Description:
[#] HMIView Settin L) $Day T -
— - Gi |
= [Z) Build Tags &) SHour eneral | Alarm | History
10 SERVER Ll $Minute —
e &l sSecond Initial Value @) False
2| Data Model Instance s
i ki SMillisecond
[T] Struct Template S
[«f| Data Model -"‘-“'SDNE
Z Nonlinear Tables &y $Time
B Alarm Groups il SUser Status Security
- System Setup I, $StartHistoryRecord | save value _|Record Event
3% ‘hiet\.o'-;':rkzetup I, $StartAERecord | Save Parameter Security Zone:
-Ca aF Sarvar K. SNewAlarm
& Current Server Config L) SRedundantStatus "] Accessed by Other App :
) Secutity Setup
=-{F Script
€3] Recipe Template EERE
a5 il Extend Field1 Extend Field2
® \J# System Script R !
[ Custom Seript Extend Field3 Extend Fieldd
=14, Custom Resource Message
L : Extend Field5 Extend Fields
anguage Setting
) Resource Manage Extend Field7 Extend Field8
@£ Resource Translate
@[ Universal DataSource E Cancel
{ A

4. In the Tag Properties screen, configure the following fields:
e Tag Name: Enter “tempReal”.
e Data Type: Select IOFloat from the drop-down list.

5. Select the I0 tab. For Access Name, click the ... button to select the ab1756 10
device (in the IO Access Selector pop-up window, click MGateIOServer > abc >

ab1756).
Tag Properties = e
Alarm G
T Tag Type larm Group
Data Type: [{:F t ']I @ Basic | Struct © Pointer

Description:

Generall 1o !A‘I‘urrn |Histu|y"

===
-]

-
10 Access Selector

M[WMOS&VU
Basic Info "\\‘
/
Access Name [ MGatelOServer
—)-abc

ommtok [ ] o755
Ttem -|[...

Read/Write Mode

@ Read Only _) Read/Write

Data Convert Settings

Min Raw Value 0

Max Raw Value 999999939

@ Linear Reverse O Sart

6. In the IO tab, configure the following fields and click OK to finish:

Copyright © 2014 Moxa Inc.
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¢ Data type: Select FLOAT from the drop-down list.

« Data Block: Select None from the drop-down list.

How to Configure KingSCADA with MGate 5105

e Item: Select or enter "TAGtemperatureReal”. The format is [TAGtagname] as

specified in Allen-Bradley ControlLogix PLC.
¢ Read/Write Mode: Select Read Only.
o Data Convert Settings: Enter "0” in the Min Raw Value field and “100” in the
Max Raw Value field.

Tag Properties ® (S|
Tag Name: temp Tag Type
Data Type: [T t Q) Basic Struct Pointer
Description: Temperature in real format
General | 1O | Alarm [History
Basic Info
Access Name MGatelOServer.abc.ab1756 [, ]
Data Block [None '] : Frequency 1000 .. \ms
Item ITAGlemEratureReai ﬂ -
Read/Write Mode
@ Read Only | Read/Write Write Only
Data Convert Settings Collect Settings
Min Raw Value 0 (V] Enabled
Max Raw Value 100 [ Force Read
@ Linear R [ I Force write

Sart {__EE._._‘_

I OK !I Cancel

Copyright © 2014 Moxa Inc.
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7. Repeat steps 1 to 5 to create another tag to read the speedReal tag from
Allen-Bradley ControlLogix PLC. Configure the tag properties as shown in the following

figure.
Tag Properties ﬁ
Tag Name: speed Tag Type
Data Type: [IOFIoat - (@) Basic Struct Pointer
Description: Speed in real format
| General | e |A|arm | History|
Basic Info
Access Name MGatelOServer.abe.ab1756 E] Data type |FLOAT -
Data Block INOHE '] Frequency 100 o |ms
Item ITAGspeedReaI ﬂ
Read Write Mode
(@) Read Only () Read/Write () Write Only
Data Convert Settings Collect Settings
Min Raw Value 0 Enabled
Max Raw Value |60 [CIForce Read
@ Linear Reverse (D) Sgrt [C] Force write
K ] ’ Cancel

Copyright © 2014 Moxa Inc. Page 17 of 30
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8. Repeat steps 1 to 5 to create a byModbus tag to read and write the byModbus tag
from/to Allen-Bradley ControlLogix PLC. Configure the tag properties as shown in the
following figure.

Tag Properties - .
Tag Mame: byModbus = =
Data Type: || 10Disc =] @gasic  Stuct O pointer

Description: Start fan control by PLC

1o Alarm | History

Basic Info
Access Name  MGatelOServer.abc.ab 1756 E] Data type | |BIT -
Data Blodk [NOHE "] Frequency 100 ... |m3
Item ITAGhyMadhus ﬂ
ReadWrite Mode
(71 Read Only () Write Only
Data Convert Settings Collect Settings
] Enabled
100 []Force Read
(@) MNone () Reverse Sqrt E [C]Force write

0K l [ Cancel

Copyright © 2014 Moxa Inc. Page 18 of 30
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9. Repeat steps 1 to 5 to create a byManual tag to read and write the byManual tag
from/to Allen-Bradley ControlLogix PLC. Configure the tag properties as shown in the
following figure.

Tag Properties - ® " I&J
TagName: byManual Tag Type
Data Type: [IODisc 2 Basic Struct () Pointer
Description:  Start fan control by PLC
| Genera|| e |A|arm | History|
Basic Info
Acress Name MGateIOServer.abc.ab1756 E] Data type I[Brr v]l
Data Block ’NOHE "] Freguency 100 ... |ms
Item ITAszManuaI ﬂ
Read/Write Mode
(7) Read Only @) Read/Write () Write Only
Data Convert Settings Collect Settings
0 . Enabled
999999999 . [|Force Read
@) None (") Reverse Sart Et [T Force write
OK l [ Cancel
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10. Repeat steps 1 to 5 to create a speed1 tag to read and write the outSpeedReal tag
from/to Allen-Bradley ControlLogix PLC. Configure the tag properties as shown in the
following figure.

L X

Tag Properties

Tag Mame: speedl Tag Type
(@) Basic Struct () Pointer

Data Type: [IDFInat b

Description:  Manual Qutput Speed

1o Alarm | History

Basic Info
Access Name  MGatelOServer.abc.ab1756 E] Data type |FLOAT -
Data Block [NOHE '] Frequency 100 ... |ms
Ttem TAGguiSpesdReal |
Read/Write Mode
(") Read Only (@) Read/Write () Wirite Only
Data Convert Settings Collect Settings
Min Raw Value O Enabled
Max Raw Value &0 [ Force Read
(@ Linear Reverse  (C) Sqrt [Tl Force write

Ok ] [ Cancel
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5.4 Creating HMI View
5.4.1 Creating a View Picture

1. Click HMI - View - Picture and click New to create a view picture.

Solution 'MGate3105' |>-::New b(DeIete lemperty| | Compile | {@Import “¥Export | & Cut 53Copy [ Paste | F4Find 2
9---@ MGate5105

&5 HMI / .. :New Picture [

e View

Name: ab
Graphics Model
- HMI View Setting
=-[=] Build Tags Comment:
..... & 10 SERVER
----- L Tag Dictionary
----- =l Data Model Instance
_____ M struct Template Window location: Window size: Picture size:
----- =i Data Model
----- Manlinear Tables
----- B Alarm Groups y: 0 Height: 758 Height: 768
[j--% System Setup
- NetWork Setup
[@-L4 Other Server Picture style

..... Border style
étcf:;e;:tiimer Config Show title bar [7]Sizeable || Clossbox ® Ncr:d @ Thin © Diclog

03 Seript . T Window style
%7 Recipe Template

File Name: ab.pic

Picture view

X: 0 Width: 1356 Width: 1386

Allow using scroll bar to adjustment larger picture view area

" @ Overlay () Alternative () Popup
System Script I I
¢ Custom Script Advance
E—]ﬂ Custom Resource Message Always open while running Hide in "open picture” dialog |
----- *4 Language Setting COpen Proje( | |
-2 Resource Manage Open soluti]| l OK I [ Cancel ] |

-8 Resource Translate
-3 Universal DataSource

2. After adding object graphics, the following figure shows the complete view picture.

B4 ab* x

SUUTOTPL/<T0VO Fieot VOO iev 0PV bfveTUOON oot POV beveTOUOE FivetUOON beeet VP vwtOOUEL ek PO Mo SOV Heves POV Py O o
3 7/////////////////////////////////////////////////////////////////////////////////////////////////////////////////////////////////////////////////////////////////////////////////A

q

Speed/Temperature Trend

g Wi

E REEE 1R (A Fi+EE T F]
1 2014/10/07 16:65:40.386 2014/10/07 16:55:42.386
=E 2014/10/07 16:55:40.386 2014/10/07 16:55:41.386

2014/10/07 16:55:40.386 2014/10/07 16:55:40.386

<

|Tota| Records: Scrolk: Status:

Copyright © 2014 Moxa Inc. Page 21 of 30




Moxa Tech Note

How to Configure KingSCADA with MGate 5105

From File > Open > Genius, you can get the Switches, Blenders, and Sign object

pictures as shown in the following figures.

Switches

F — —— —— —
+ Graphy Otjec seiecror e o

0O =

X =

Path Name: C:\Program Files\KingSCADAbIN\GLib\Switches.kan

{3 Fans

[-{3 Lights-General
-3 MaterialHandling
{38 Meter

-3 Matars

{38 Mature

{3 Pumps

[-{3] Retorts-General

-~

,

W

m

-3 SafetySymbols Switches003 Switches004 tl
-{3] Sensor i
-3 Sign
[H-{3) Sliders-General I
-3 Stuff Guages =
i~
{3 Valves I
i (-3 Pipes-General
-3 SimpleShapes
- Etﬂm | Switches005 Switchesd0& |
|
[ o« | [ cancal |
A R - §
Blenders
T —

=

X

Path Mame: C:\Program Files\KingSCADAbIN\GLb\Blenders.kan

===

=-{3g Predefined

(3 Arrows
-3 BackGround
{3 Logo
{3 Panels
=3 Blender

"=
-3 Building
({3 Buttons
- Clock
[-{3] ComputerSymbal
{3 Containers
{3 ConveyorBelt
{3 CoolingDevices
[-{3) ElectricalSymbals
(3 Fans
({3 Lights-General

-3 MaterialHandling
1.8 Metsr

m

Blenders001

)

Blendersd03

l

Blenders005

Blenders002

Blendersd04

m

] ’ Cancel
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1 Graphy Object Select e ele

0@ x 2

Path Mame: C:\Program Files\KingSCADA RN \GLIL\Sign.kgn

E Lights-Warning -

-3 MaterialHandling

[=-{38] Meter

{3 Digital Meters

{? Counters

{38 Motars

-3 Mature Temperature Gauge

-3 Pumps

[=-{3] Retorts-General

-{3] Retorts-Specl

{3 SafetySymbals

{3 Sensor

i

[=-{3) Sliders-General
E Sliders

-3 Stuff Guages

-3 Switches
... T Wahiae
F 1 | r

5.4.2 Adding Links

After adding the object pictures, add links to enable the system to dynamically

update object graphic animation or input and output element value.

1. Select the Temperature input box; then, in the Links window, click the + icon to add

the AnalogOutput source as the \\local\temp tag.

|D |1D'D |2CHJ |3{HJ |4D'D |51]'D |B{HJ |7EHJ |3D'D |9EH} |1
P TR PR PRET T FUTT] PTTURTETE PATT FUTT PRI FUTT PUTE FTERE PR PRTTE PR ST PT ree

i ab X T

& ==

e o o e L i S e
1%

g Value Output

o fige E

AnalogOutput | \Wocaltemp

/

[semraaong @] | [ ssaino (] |waes (]| =ne1 8
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2. Select the Speed input box; then, in the Links window, click the + icon to add the
AnalogOutput source as the\\local\speed tag.
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3. Select the Modify Speed input box; then, in the Links window, click the + icon to add

the AnalogOutput source as the \\local\outSpeed1 tag and the AnalogInput
source as the \\local\outSpeed1 tag.
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4. Select the Start/Stop Switch; then, in the Input window, click the + icon o add the
Value source as the \\local\byModbus tag.

&4 ab” x Links B x‘@
+ ==

“ |3 Values(Required)

Value \\ocahbyModbus
Ll
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Speed/Temperature Trend

[swadm,{ﬁ [0 (] [wapeoy —r

Copyright © 2014 Moxa Inc. Page 24 of 30




Moxa Tech Note

How to Configure KingSCADA with MGate 5105

5. Select the Manual Control switch; then, in the Input window, click the + icon to add
the Value source as the \\local\byManual tag.

Speed/Temperature Trend

Tiabs o Links = x|
|ﬂ . |1Dﬂ| ‘200‘ ‘300‘ |m| |500| ‘BDD‘ ‘TMI |BD0I |BDD‘ ‘100!") ‘Mflq |120q ‘130!"3 “WM & = |
iz | S il Required)

Value ‘Wocal\byManual

--"""—'

5.4.3 Adding a Trend Curve

1.
curve chart.

4 PictureEditor

[sovadarg @] | [syostao [ [wamor [E] [snn1 69 |

In the PictureEditor screen, click Object & Extend 2 Trend Curve to create a trend
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2. Right-click on the Chart object and click Add Curve to add the Speed and
Temperature curves that are linked to the \\local\speed and \\local\temp tags
respectively.
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SpeedTemperature Trend
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Add Curve
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5.4.4 Adding an Alarm Window

1. In the PictureEditor screen, click Object > Extend > Alarm window to create an
alarm window.
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2. Configure the alarm settings for the Temp tag as shown in the following figure.

Tag Properties a— . P - (S|
Tag Name: | temp Tag Type
Data Type: [IOFIoat - @) Basic Struct Pointer
Desaiption: Temperature in real format
| General | (o] | Alarm |Hist0ry|
Limit Alarm Settings ROC Alarm Settings
Limit Value  Alarm Text Priority  Alarm Inhibitor
el [0 LoLs T 2 [CRee )
(@ Second
Lo 10 TooCold 1 |2 20 . |26 ) Minute
S Hour
V] Hi 20 .| Too Hat 1 =
Alarm Text  Priority
[FHiH | 100 . || HiHi 1 ? ROC 1 :
|:| Dead 0 [ Delay 0 Sec Alarm Inhibitor
Dev Alarm Settings :
Limit Value  Alarm Text Priority  Alarm Inhibitor
f [CImajor |50 .| Magor 1 B ? Delay [0 | 5ec
[FIMinor | 20 . || Minor 1 : g
Alarm Group:
Target | 100 Dead Band |0 Delay |0 | Sec
[ oK ] [ Cancel ]

3. Configure the alarm settings for the Speed tag as shown in the following figure.

Tag Properties — e p. - [t |
Tag Name: |speed Tag Type
Data Type: [IOFIoat - @) Basic Struct Pointer
Description: Speed in real format
| General | 10 | Alarm |Hist0ry|
Limit Alarm Settings ROC Alarm Settings
Limit Value  Alarm Text Priority  Alarm Inhibitor
[Ciele [0 [Lote 1 E ? [Croc ]
(@ Second
Wllo 10 | Speedlow |1 |2 2] [0 ][] Minute
S Hour
WIHi 50 .| Speedhigh |1 |£ 2
] s = Alarm Text  Priority
[ElHH | 100 . || HiHi 1 ? ROC 1 :
|:| Dead 0 |:| Delay 1] Sec Alarm Inhibitor
Dev Alarm Settings :
Limit Value  Alarm Text Priority  Alarm Inhibitor
[CImajor [0 [ magor T 2 Delay |0 | sec
| [FIMiner | 20 . [ Minar 1 : ?
Alarm Group:
Target | 100 Dead Band |0 Delay |0 |Sec
OK ] [ Cancel
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5.5 Compiling a Project
Click Compile to compile project. Make sure that there is no error or warning in the
Output tab window.

S . . e -

File Edit View Compile Tools Help

u New [—?' Add @ Open Find EI Large |-==| Details 21 Compile E‘ Graphy ﬂ View 0 About .

T} Solution 'MGate5105' b::New X Delete [&] Property | <fifompile | @@Import (MExport | # Cut E3Copy [4Paste | FAFi
522 MGate5105 -
5.5 HMI Ed
Ly View ab

& Graphics Model

% HMI View Setting
=[5 Build Tags Output
IOSRVR e
%] Data Model Instance Begin Compiling DataModel... IMGate5105
Struct Template End Compiling DataModel. MGate5105
5| Data Model »>Compile Application Scripts: Project( MGate5103)
..... =] Monlinear Tables »>Compile success: void OnApplicafionStartUp( ) Project(MGate5105).L
B Alarm Groups »»Compile success: void OnApplicafionRunning( ) Project(MGate5103).L
- System Setup »>Compile success: void OnApplicafionStop( ) Project(MGate5103).L
-4 _NEt\'""Drk Setup »>Compile Alarm Scripts: Project( MGate5105)

& Other Server

»=Compile success: void OnAlarmEdent_Disc( DiscTag bTag, long filetime, lon... Project(MGate5105).L
-4 Current Server Confic

..... &) Secutity Setup
=1-{& Script

»>Compile success: void OnAlarmEdent Int( IntTag iTag, long filetime, long ev... Project(MGate5103).L
»>Compile success: void OnAlarmEdent_Float( FloatTag fTag, long filetime, lo.. Project(MGate5105).L

%] Recipe Template »>Compile User Login Scripts: Project( MGate5105 )
[F] System Script > >Compile success: void OnLogOn(fstring Username ) Project(MGate5105).L
= Custom Script »=Compile success: void OnLagOff§ ) Project(MGate5105).L
=] Custom Resource »=Compile Data Change Scripts: Project( MGate5105 )
-3 Language Setting »>Compile Event Scripts: Project( MGate5105 )
£.] Resource Manage »»Compile Custom Function Scripts] Project{ MGate5105 )
.Resource Tanslate | Compile Hotkey Scripts: Project({ MGate5105 )
&-Ep Universal DataSource »>Compile Timer Scripts: Project( MGate5105)
= =Compile picture - I'\-"IGateSlDS.al‘r Project(MGate5105).F
==MGate5105.ab - 0 error(s), Dw:lmians] Project(MGate5105).F
M Output | find Results | Error List

mood.

6 Runtime Test

Before you execute ScadaView, you must start the IO server first.

1. In the IOServer Configure program, click Start to start the IO server.

k3 105erver-C:\Program Files\KingSCADA\My Projects\MGate5105ab
Flle Edit Wew Acguisiion Tools Help

pii Mew <= Open o Close | |¢ Start ' Diagnosis = Debug Message | i DriverSetup (&) Monitor About I0Serv
Device Tree o x E’;alx.ah]?&&
&l P
= T:jJ ':J:;tc ab MName D Register DataType Address From
w abl758
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2. Inthe ScadaMake program, click View to run the SCADA View system. Alternatively,
you can execute the ScadaView program to run this project.

peeerEEs @& 2 e

JFile Edit View Compile Tools Help

J I_} Mew E} Add @ Open Find Large Details Compile Graphy View @ About .

Selution 'MGate5105' b Mew @Edit XDeletel # AddMNext 3{i':‘:lf\::h:lBatcl"l E3Copy | Paste t';:@Impcur‘i: @Exp(
-)-.22) MGate5105 .
= 3 2 :h:ll Mame Description Type D
=] é View Qﬂﬂ"ear Memlnt32 1
¢ L Picture Lil SMonth Memlnt32 2
& Graphics Model iyl SDayof\Week Memlnt32 3

Pl LR AT A C kb dem_.. RA o Tornn

The screen displays the HMI View. SCADA polls the tags of Allen-Bradley ControlLogix
PLC and updates values on the HMI View (for example, displaying the current temperature
and speed values).

You can click the Start/Stop switch to start or stop the PowerFlex 4M converter.

If you user a hairdryer to increase the meter temperature, the converter will increase its
output speed. The Speed/Temperature Trend Chart area will also show the trend of
the temperature and speed change. If the temperature or speed value exceeds the alarm
threshold, the system logs an event in the Alarm Window area.

Speed/Temperature Trend
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If you click the Manual Control switch to enable the manual speed control function, an
Input dialog box appears that allows you to specify the speed value in the Input analog
value field.
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